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1 Formatting requirements and thesis template 

This document presents author guidelines and formatting requirements for thesis 

defended at the School of Information Technologies at Tallinn University of Technology. 

These requirements are obligatory for all bachelor’s and master’s thesis (further referred 

as thesis). Sections 1 and 2 of this document constitute formatting requirements whereas 

Sections 3 and 4 provide helpful hints for word processing with MS Word and 

LibreOffice Writer correspondingly. Authors are strongly advised to familiarize with 

Sections 1 and 2 before starting to write thesis. This document is formatted according to 

the requirements declared in this document, and acts as an example of correct formatting. 

1.1 Authors’ toolkit 

Authors are encouraged to download and use the templates prepared to ensure correct 

formatting of thesis. Templates are available for Word processing programs MS Word 

(version 2016 and newer) and LibreOffice Writer (version 7 and newer). The authors’ 

toolkit is downloadable as a single archive file in ZIP-format.  

The toolkit contains guidelines and templates to compose thesis in Estonian or in English. 

Authors should download the toolkit file, and unzip it to their computer to a folder of their 

choice. The toolkit archive contains the following: 

▪ Author guidelines and formatting requirements document (PDF) 

▪ MS Word templates:  

− Template with predefined styles, thesis structure and title page 

(FIT_template_with_structure_ENG.dotx); 

− Template with predefined styles and title page only 

(FIT_template_ENG.dotx);  

▪ LibreOffice templates:  

− Template with predefined styles, thesis structure and title page 

(FIT_template_with_structure_ENG.ott).  
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To create a new text document based on the template authors should open it by double-

clicking on the template file name. Opening template file with the Open command opens 

the template for editing.  

1.2 General formatting requirements 

Thesis must be formatted on an A4 page (210 x 297 mm), with margins from left and 

right set to 30 mm, and top and bottom 25 mm. The content text layout is in one column.  

The thesis font is Times New Roman 12 pt Regular. Correct formatting of text is ensured 

with the use of the style Body Text that has the following properties: Times New Roman 

12 pt Regular, line spacing 1.5, spacing after 12 pt, text alignment Justify. The style Body 

Text is based on style Normal. Table 1 lists all the requirements for different document 

parts and styles available in the template to ensure correct formatting.  

Words or sentences which need highlighting can be presented as double-spaced, in 

Bold or Italic (e.g., expressions in foreign language).  

The font colour of the paragraphs and headings is black. The use of colours on figures is 

not limited.  

The content of the thesis is structured into sections using up to three levels of headings. 

Adding a new level is justified if it contains more than one paragraph of text. The use of 

level 4 headings (Heading 4) must be avoided. First level headings (Heading 1) always 

start a new page. Headings are numbered using Arabic numerals. Multilevel headings 

contain a reference to higher level heading, whereas the numbers are separated by a dot.  

As an exception the following headings are not numbered: Author’s declaration of 

originality, Abstract (Annotatsioon, Aннотация), List of abbreviations and terms, Table 

of contents, List of figures, List of tables, References, Appendixes. Headings for 

appendixes always start with a word Appendix, which is followed by a number, no 

automatic numbering is applied. 

Correct formatting of headings is ensured with the use of styles available in the 

template: Heading 1, Heading 2, and Heading 3.  
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1.3 Formatting requirements and styles available in templates  

To ensure correct formatting of thesis and help authors in this process the templates 

contain different style definitions applicable for different document parts. These styles 

are based on the style Normal: Times New Roman 12 pt, Regular, space before and after 

0 pt, spacing Single. Table 1 lists document parts and styles defined for their correct 

formatting together with the requirements.  

Table 1. Formatting requirements and applicable styles in the templates. 

Document part Style name  Settings 

Thesis code Centred Times New Roman 12 pt, centred 

In further referred as Lettering. Author’s details 

Thesis type 

Supervisor’s details Normal Lettering 12 pt, align left  

Thesis title Heading_title Times New Roman 20 pt, Bold, centred 

Thesis body text Body Text Times New Roman 12 pt, line spacing 1.5, 

spacing after 12 pt, justified 

Headings: 

– References 

– Appendixes 

Heading_unnumber Lettering 16 pt, Bold, spacing before 60 pt, 

after 18 pt, align left. Starts a new page. No 

numbering. 

Headings: 

– Table of contents 

– Author’s declaration of 

originality 

– Annotatsioon 

– Abstract 

– List of abbreviations 

and terms 

– List of figures 

– List of tables 

Heading_center Lettering 16 pt, Bold, spacing before 60 pt, 

after 18 pt (like Heading 1). Starts a new page. 

No numbering. 

Level 1 heading Heading 1 Lettering 16 pt, Bold, align left, spacing before 

60 pt, after 18 pt, numbered with Arabic 

numerals, space between number and heading 

text, starts a new page.  

Level 2 heading Heading 2 Lettering 14 pt, Bold, align left, spacing before 

24 pt, after 12 pt, numbering with Arabic 

numerals and a reference to higher level 

heading with a dot between numbers (e.g. 1.1) 
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Document part Style name  Settings 

Level 3 heading Heading 3 Lettering 12 pt, Bold, align left, spacing before 

and after 12 pt, numbering with Arabic 

numerals and a reference to higher level 

heading with a dot between numbers 

(e.g. 1.1.1) 

Table header Table_head Lettering 11pt, Bold, align left, line spacing 

1.15, space before and after 3 pt 

 – Table text 

 – Terms in the list of 

abbreviations 

Table_text Lettering 11 pt, align left, line spacing 1.15, 

space before and after 3 pt 

Figure/Table caption  

single line 

Caption Lettering 10 pt, line spacing 1.15 

space before and after 6 pt, centered 

Figure/Table caption  

multiline 

Caption_multiline Lettering 10 pt, line spacing 1.15 

space before and after 6 pt, Justify 

Program code Program_code Consolas, 11 pt, single line spacing,  

space before and after 2 pt, align left  

Equations  

(on separate line) 

Equation Lettering 12 pt, single line spacing,  

space before and after 12 pt 

Bulleted list List Bullet Lettering 12 pt, square bullet, line spacing 1.5; 

bullet indentation 0.63 cm; spacing 12 pt, 

Justify, no spacing between lines of bulleted 

list 

Numbered list List Number Lettering 12 pt, line spacing 1.5; space 12 pt, 

indentation 0.63 cm; Justify, no spacing 

between lines of numbered list 

Items in the list of 

abbreviations and terms 

Normal or  

Table_text 

Lettering 12 pt, line spacing 1.5; spacing 0 

References References Lettering 11 pt, line spacing 1.15, spacing 

11 pt 

Footnotes Footnote Text 

Lettering 10 pt, line spacing 1.15, spacing 

before and after 0 pt, restart numbering for 

each page 

Figure Figure Centred. The style adds a frame and necessary 

space around  
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Document part Style name  Settings 

References list  List_bibliogr Times New Roman 11 pt, numbered with 

numbers in square brackets, spacing before and 

after 2 pt 

Row in Table of 

contents: 

– Level 1 

– Level 2 

 

– Level 3 

 

 

TOC1 

TOC2 

 

TOC3 

 

 

Lettering 12 pt, line spacing 1.5; align left 

Lettering 12 pt, line spacing 1.5;  

indentation 0.42 cm 

Lettering 12 pt, line spacing 1.5;  

indentation 0.85 cm 

1.4 Thesis volume 

The volume of bachelor’s thesis main content should remain in the range of 25 to 35 

pages, and for master’s thesis in between 30 to 60 pages. The main content does not 

include the title page, abstract, table of contents, list of references and appendices.  

Despite the given ranges, the number of pages of the main content of the thesis should be 

as large as necessary and as small as possible. The text must be presented concisely and 

the excess number of pages is permissible only in well-justified cases. 
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2 Thesis structure and requirements  

This section provides an overview of the requirements for thesis structure. The thesis 

consists of various required and optional parts always presented in the order specified 

herein. Table 2 lists the parts of the thesis document in the required order.  

Table 2. Mandatory and optional parts of thesis in the required order of their presentation. 

Thesis part Conditions 

Title page  Required 

Thesis written in foreign language (e.g., English) have 

2 title pages, the first in the language of thesis and the 

second in Estonian 

Author’s declaration of originality  Required (see 2.3 Author’s declaration of originality) 

Thesis task page Optional (see conditions in Section 2.3) 

Abstract in thesis language Required (see conditions in Section 2.5) 

Abstract in other languages Required (see conditions in Section 2.5) 

List of abbreviations and terms Required (see conditions in Section 2.6) 

Table of contents Required 

List of figures Optional; presented only if thesis contains figures 

List of tables Optional; presented only if thesis contains tables 

Introduction Required 

Chapters of thesis subject 

development 

Required 

Summary Required 

References Required 

Appendix 1 Required (see Section 2.9 Non-exclusive licence) 

Appendix 1 presents Non-exclusive licence 

Appendices Optional (except required Appendix 1 Non-exclusive 

licence); presented only if thesis contains any 
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2.1 Title page 

The title page is formatted using the same font as the rest of the thesis, i.e., Times New 

Roman1. The top of the page must include the name of the university, school and 

department. The location and the year of the thesis defence are presented at the bottom of 

the page. Title page is formatted using a table, as shown in Appendix 2. It has separate 

header and footer from the rest of the thesis. Author’s first, middle and last name, and 

student code are presented on separate lines. These are followed by thesis title and type 

(bachelor’s/master’s thesis). Supervisor(s) name(s) and detail(s) are presented after thesis 

type. If necessary, consultants are listed as last. 

Thesis written in English (or any other foreign language) has two (2) title pages: the first 

in the language of thesis and the second in Estonian. Thesis written in Estonian has only 

one title page. 

2.2 Page numbering 

All pages must be numbered. Numbering must be pervasive and include every page from 

the title page until the last page of appendices. Page numbers are presented at the bottom 

of the page (in footer) and aligned centred using the style Footer or font 12pt. Page 

numbers are placed 1.5 cm from the bottom edge. There is no page number on title pages; 

still they are counted in the numbering. 

2.3 Author’s declaration of originality 

Author’s declaration of originality is a required part of every thesis that follows the title 

page (Appendix 3). The statement of author’s declaration of originality is as follows: 

I hereby certify that I am the sole author of this thesis and this thesis has not been 

presented for examination or submitted for defence anywhere else. All used materials, 

references to the literature and work of others have been cited. 

Author: [First name Middle name(s) Last name] 

[dd.mm.yyyy] 

                                                 
1 It is allowed to use other serif fonts alike to Times New Roman such as Times for example 
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2.4 Thesis task specification 

The thesis must contain an explicit description of the problems the author is solving in 

the thesis work. 

For Bachelor’s thesis the task is formalized as a separate task specification document 

(established by the department where the thesis will be defended; ask for the task sheet 

form from your supervisor), or is specified in the Introduction section of the thesis 

covering the following: 

▪ Problems to be solved and initial conditions of the task,  

▪ Special conditions applicable for solving the specified problem (if any). 

Filled task sheet form is added to the thesis as a separate page after Author’s declaration 

of originality. 

For Master’s thesis the task specification must be covered in thesis Introduction section 

through the following points:  

▪ Problems to be solved and initial conditions of the task,  

▪ Special conditions applicable for solving the specified problem (if any).  

2.5 Thesis abstract 

Abstract is a mandatory part. It provides an overview about the aims, the most important 

issues, results and conclusions of the thesis. Abstract is a short overview of thesis which 

does not explain or justify the content but provides an overview of the most important 

aspects. An abstract in Estonian is called Annotatsioon and in Russian Aннотация. 

Depending on the thesis language the following abstracts must be included: 

▪ If the thesis is written in English, the abstract is ½ A4 pages long and the abstract 

in Estonian (Annotatsioon) is of length of 1 A4 page (except in case of the 

graduation theses of degree curricula taught in English). 

▪ If the thesis is written in any other foreign language not English nor Estonian (e.g., 

Russian), the abstract in thesis language is ½ A4 pages long, which is followed by 

an abstract in Estonian (Annotatsioon) of length of 1 A4 page, and an abstract in 

English of length of 1 A4 page.  
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For abstracts not in the main thesis language thesis title in foreign language is added in 

between the heading Abstract and the abstract content. Abstracts in different languages 

are presented on separate pages – abstract heading is a level 1 heading which starts with 

a new page. 

The last paragraph of abstract is obligatory and must be written accordingly: 

The thesis is in [language] and contains [pages] pages of text, [chapters] chapters, 

[figures] figures, [tables] tables. 

The abstract in Estonian (Annotatsioon) has the following obligatory ending: 

Lõputöö on kirjutatud [keel] keeles ning sisaldab teksti [lehekülgede arv töö põhiosas] 

leheküljel, [peatükkide arv] peatükki, [Figurete arv] Figuret, [tabelite arv] tabelit.  

NB! Headings „Author’s declaration of originality”, „Abstract”, etc. are formatted as 

unnumbered and centred level 1 headings (style Heading_center) and are not presented 

in the table of contents. An example of Abstract is presented in Appendix 4. 

2.6 List of abbreviations and terms 

The list of abbreviations and terms must contain all new and ambiguous terms. For 

example, the abbreviation PC can be used as Personal computer or Program counter. 

Abbreviations and terms are presented in a table of two columns where the left column 

contains terms or abbreviations and the right column provides their explanations. Foreign 

words are presented in italic. This table does not have any border lines (for table 

formatting in MS Word please refer to Section 3.5 and in LibreOffice Section 4.7).  

The text in the list of abbreviations and terms table is formatted using the style Table_text. 

Appendix 7 presents an example of this table layout1. The width of this table is the 

maximum size of the content area; the distribution of the left and right column widths is 

up to the author.   

The heading of this section is level 1 heading starting with a new page. Use the 

style Heading_center for correct formatting.  

                                                 
1 To add a new row to the table with the same formatting press TAB in the last cell of the table. 
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Each abbreviation presented in the main text must be explained on the first occurrence. 

For example, if an abbreviation PC is used, then it should be accompanied with 

explanation in parentheses, e.g. PC (Personal Computer). 

2.7 Table of contents, list of figures and list of tables  

The table of contents lists the headings and corresponding start page numbers for all parts 

of the thesis – sections (chapters) and subsections – starting from Introduction and ending 

with Appendices. The table of contents is composed and structured according to headings.  

If thesis is composed using the provided template and the author has used the heading 

styles as specified, the table of contents is generated automatically after an update is 

performed on the “Table of Contents” page.   

The list of figures presents only the figures available in the main part of the thesis – figures 

presented in appendices are not listed here. The heading „List of figures” starts with a 

new page. An example is given in Appendix 5. 

The list of tables presents only the tables available in the main part of the thesis – tables 

presented in appendices are not listed here. The heading „List of tables” starts with a new 

page. An example is given in Appendix 6. 

The lists of figures and tables are generated automatically after an update if the author 

has applied correct captions as specified in the template.  

2.8 Thesis content formatting 

This section addresses formatting requirement for the main parts of thesis starting with 

Introduction. 

It is advised to start thesis composition by downloading the author’s toolkit and using the 

provided template. The templates contain ready-made styles that follow the requirements 

established in this document. Table 1 (page 7) provides an overview of available styles 

and their settings. 
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2.8.1 Formatting the main parts of thesis 

In thesis Introduction the author presents the topic of the thesis, its goals, and highlights 

which problems will be solved. Also, the division of the thesis subject development into 

chapters is presented. Introduction must contain starting conditions, subtasks and if 

needed – additional requirements (see Section 2.4). 

In thesis Summary the author presents the main goal of the thesis and provides answers 

to problems stated in the Introduction. Summary must also present the main results and 

important findings of the thesis.  

The division of thesis content into sections and subsections has to be rational – sections 

and subsections with only one paragraph of text must be avoided; they should be included 

into some other section. The maximum depth of headings is three (3) levels, the use of 

level 4 headings is not allowed. 

In all sections and subsections, the heading must be followed with text content. Authors 

are discouraged to add new heading, figure or table immediately after heading. Level 1 

headings always start a new page, the space before the heading is 60 pt and after 18pt. 

Correct formatting of first level headings is ensured by exploitation of style Heading 1; 

do note that different parts of thesis may have different requirements for headings (see 

Table 1). The peculiarities of adding level 1 headings in MS Word version 2013 and 

newer are presented in Section 3, page 22.  

2.8.2 Figures and tables 

All figures and tables in the thesis main part must be numbered and captioned with a title. 

Numbering of figures and tables must be separately pervasive. Figure number and caption 

are added under the figure, table number and caption are added above the table. Figure 

caption starts with a word “Figure” followed by a space, number, a dot, and figure title. 

Table captions start with a word “Table” and follow the same formatting pattern. 

Figure/Table caption always ends with a dot. 

Single line captions are aligned to centre (use style Caption), whereas multiline captions 

are aligned as justify (use style Caption_multiline). Figure/Table caption must be on the 

same page with the figure/table. Adding captions to figures and tables in word processing 
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is described in more detail for MS Word in Section 3.6 and for LibreOffice Writer (LO) 

in Section 4.6.  

Figures and tables are placed into document separate from content text – the content text 

is above and below figure/table and never on the left or right – and centred. All figures 

and tables must be referred to in text and appropriate explanations provided. A reference 

to a figure or table within text must occur before the figure or table itself.  

For figures and tables in language other than the thesis main language the original text 

may be preserved, if necessary it is presented in Italic. Abbreviations used on figures or 

in tables must be explained in caption title; if the abbreviation is used also elsewhere in 

the thesis, it must be added to the list of abbreviations and terms. The use of marking and 

symbols different from the thesis main content is allowed for figures.  

An extra empty line of cells without borders is added at the end of table, to ensure enough 

spacing between the table and the following text. If a table spans across multiple pages, 

the header row is duplicated at the beginning of each page (for an example see Table 1). 

It is recommended to avoid such tables whenever possible. 

Figures (vector graphics) and illustrations (raster graphics) must be of printable quality. 

The lettering in figures should not use font sizes smaller than 6pt (~2mm character 

height). The correct process of adding figures into thesis document using the styles in the 

template is described in Section 3.3 for MS Word and in LibreOffice in Section 4.6. 

Figure 1 presents a correctly formatted example of figure with short single line caption.  

Figure 2 presents correctly formatted example of a figure with long multiline caption.  

 

Figure 1. Example: Taltech main logo. 



17 

For multiline captions style Caption_multiline is applied to or align Justify. 

Figure 3 presents the correct formatting and referencing of different parts of the figure in 

caption title in case of a multi-part figure. 

2.8.3 Program code 

Program code (source code) is formatted on the same principles as figures using 

monospaced font (for example Courier, Courier New or Consolas) with single 

line spacing. The template contains a defined style Program_code for this purpose. Figure 

4 presents an example of formatted program code.  

Program code must always be correctly intended. The code is presented continuously on 

the same page, whenever possible. This is achieved by style Program_code and its 

application during formatting.  

The first line of the program code starts from the left border. To obtain visually horizontal 

centred alignment, select the whole code and use the Increase Indent option. 

 

Figure 2. Example: School of information technologies logo. The stand-alone or silhouette versions of the 

main logo can be locked up with up to four lines of text to denote different schools within TalTech 

University. The line height of the locked up lines is equivalent to 20% of the ‘X’ height of the main TalTech 

word mark, and should be applied with equal line spacing, as illustrated on the right hand side. 

 

Figure 3. Example: School of information technologies logo: (a) in Estonian, (b) in English.  
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Program code is captioned as figure.  

Public Function computeSomething() 

   Dim i, j As Integer 

   For i = 1 To 10 

     For j = 1 To 10 

        ' Do something in loop 

      Next j 

   Next i 

   Return i + j 

End Function 

 

Figure 4. Correctly formatted and intended example of program code. 

2.8.4 Mathematical expressions and equations 

Numbering mathematical equations is mandatory in case there is a reference to them in 

the text. In all other cases numbering is optional. The number is placed on the same line 

with the equation on the right side of the page in parentheses. Equation (1) presents an 

example of correct formatting and referencing.  

(𝑥 + 𝑎)𝑛 =∑ (𝑛
𝑘
)𝑥𝑘𝑎𝑛−𝑘

𝑛

𝑘=0
 (1) 

The tab stop for the number on the right is set to 14.8 cm, and is included in the style 

Equation. 

2.8.5 Citing and references 

Numeric style should be used for references. There are two options to list references: 

ordering references by author name and title in alphabetical order, or in the order they are 

cited in text. The list is numbered with consecutive Arabic numbers in square brackets, 

year of appearance is added at the end of the reference record.  All used sources must be 

cited, including printed and electronic materials. The list of references must only include 

the sources, which have been actually used in the thesis, and which have been referenced 

in the text. When the list of references and the references in the text are non-compliant, it 

will call into question the merits of the work, as well as formatting accuracy.  

For citations in the text, please use square brackets and Arabic numbers. The reference in 

the text is always included into a sentence, either immediately after mentioning the 

source, at the end of the sentence (before the ending dot), or at the latest at the end of the 

related topic paragraph’s last sentence. A reference must be placed to text at the first 
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(suitable) chance, repeated citing is allowed. The reference number is never alone outside 

a sentence. Sentence never starts with a reference. Multiple references are presented in 

the ascending order each number in separate square brackets, e.g., [5], [7], [33], with a 

range of references a dash can be used e.g., [8]–[13]. When referring or citing a specific 

idea, sentence or data, a page number(s) must be added to the reference, e.g. [2, p 35]. 

Reference to a whole book, a book chapter, article, or other source can be used if the 

reference is based on the argument of the work as a whole. 

Word processing MS Word includes a reference processing system to manage sources – 

this is covered in Appendix 8. 

If the number of referenced sources is not large, the numbered references list can be 

composed manually using the style List_bibliogr included in the template.  

2.8.6 Appendices 

Appendix 1 presents Non-exclusive licence, that is a required part of every thesis (see 

Section 2.9 Non-exclusive licence).  

The following appendices are used to present materials that add value to the main part of 

the thesis, help to understand a problem, provide additional details etc. The main text 

must contain a reference for all added appendices (except Appendix 1 Non-exclusive 

licence); Appendices are not counted into the volume, and the use of them is optional 

(except required Appendix 1 Non-exclusive licence).  

Appendices are numbered in the ascending order (no automatic numbering of headings is 

used) with Arabic numbers and formatted as first level headings aligned to left (style 

Heading_unnumber). Although the formatting of appendices is free, it is advisable to 

follow the guidelines and requirements applicable for the main part of the thesis.  

2.9 Non-exclusive licence 

The non-exclusive licence for reproduction and publication of a graduation thesis is a 

required part of every thesis and one of the prerequisites for allowing the author to defend 

his/her thesis and ensuring the protection of his/her copyright. An example of the non-

exclusive licence is presented in Appendix 1. The non-exclusive licence is as follows: 
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2.10 Hints for text processing 

In order to take full advantage of the provided template, word processing program should 

be used in a correct manner. Word processing is not typing a text on a typewriter. The 

following list draws attention to some common errors made during word processing: 

▪ Words are separated by only one space character between them. If a word is 

followed by a punctuation mark, punctuation follows the word immediately, and 

a space character is added after punctuation. Redundant spaces should be 

removed, for instance by search and replace. 

▪ Word processing automatically takes care of dividing text to lines. The division 

of text into paragraphs is done by author by pressing the Enter key on keyboard, 

which adds a non-printable paragraph end mark ¶.  

▪ Sometimes it is necessary to keep words or symbols together so that they will not 

be distributed on separate lines, for example initials of given name and surname. 

To add such a nonbreaking space use keyboard combination Ctrl+Shift+Space. 

▪ To hold together words separated with hyphen, use nonbreaking hyphen, which 

can be added with keyboard combination Ctrl+Shift+hyphen. 

I [First name Middle name Last name] 

1. Grant Tallinn University of Technology free licence (non-exclusive licence) for my 

thesis "[Thesis title]" , supervised by [Supervisor’s name]  

1.1. to be reproduced for the purposes of preservation and electronic publication of 

the graduation thesis, incl. to be entered in the digital collection of the library of 

Tallinn University of Technology until expiry of the term of copyright; 

1.2. to be published via the web of Tallinn University of Technology, incl. to be 

entered in the digital collection of the library of Tallinn University of Technology 

until expiry of the term of copyright. 

2. I am aware that the author also retains the rights specified in clause 1 of the non-

exclusive licence. 

3. I confirm that granting the non-exclusive licence does not infringe other persons' 

intellectual property rights, the rights arising from the Personal Data Protection Act 

or rights arising from other legislation. 
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▪ A dash (–) is longer than hyphen and it is not the minus symbol. An easy way to 

add dash into text is Ctrl+Numpad minus symbol, or Alt+0150. 

▪ Hyphenation should not be something to worry about. If you want to hyphenate a 

word manually, just add Ctrl+Hyphen.  

▪ To break a long line (e.g., title), add a line break by pressing Shift+Enter.  
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3 Using MS Word for preparing thesis 

This section addresses issues common of word processing in Microsoft Word, in 

particular composing text, inserting tables, figures, adding captions to the latter, 

managing list of references and so forth.  

The MS Word template in the author’s toolkit is established to help authors in preparing 

their thesis. Proper use of the template ensures correct formatting of thesis and the author 

can focus on content only. 

Opening the template, you will see pre-defined document parts with constant text and 

changeable parts shown in square brackets – these should be changed according to thesis 

contents by clicking on the text and inserting new content – the template will take care of 

proper formatting. 

The numbered headings in thesis are formatted using predefined styles Heading 1, 

Heading 2, Heading 3. After you have typed the heading, applied proper style and pressed 

the Enter key at the end of the heading line, the next line will be formatted to content text 

input automatically having its style set to Body Text. This style ensures proper formatting 

of paragraphs and their spacing. 

NB! Due to the peculiarities of MS Word as of version 2013 first level headings are 

formatted as indicated in Table 1. In order to start level 1 heading from a new page and 

guarantee that the text content begins at the correct height from top border it is necessary 

to add Section Break (Next Page) at the end of the text preceding the level 1 heading AND 

apply style Normal to it (Figure 5). 

When cursor is on the new page, type the heading text and apply style Heading 1 to it. 

Doing so will guarantee that there is a space of 60pt in front of the first level heading as 

required. Pressing the Enter key at the end of the heading line will take the cursor to a 

new line with proper style Body Text available for text insertion.   
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3.1 Text entering and layout 

The rules to follow while entering text are presented in Section 2.10. Text formatting 

should be done using available styles. All styles available in the template are listed in 

Table 1. To display the list of styles, choose from the menu Home, Styles and open the 

list from the arrow on the right bottom corner (Figure 6). Alternatively, you can use 

keyboard combination Alt+Ctrl+Shift+S. 

A click on a style name (e.g., Heading 1) will apply it to the paragraph where the cursor 

is, or to selected paragraphs. To display all styles available in the document, choose from 

the bottom of styles panel (Figure 6) Options   and in the 

Style Pane Options window set Select styles to show – In current document.  

To paste styles and formats you can also use the Format painter tool from 

the Home menu or from right-click context-menu . 

 

 

Figure 6. Displaying all styles. 

Page Layout,  

Breaks,  

Section Breaks, Next Page 

 

Activate the row  

Section Break (Next Page) and 

apply style  Normal 

Figure 5. Preconditions for inserting level 1 heading in MS Word 2013 and newer. 
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3.2 Footnotes 

Footnotes are added at the bottom of the page, just above the bottom margin. Footnotes 

numbering is restarted on each page. The proper style for footnotes is Footnote. To add a 

footnote, place a cursor in the text at the place where you want your footnote reference to 

appear and choose Reference, Insert Footnote. From the Footnote and Endnote dialogue 

window (Figure 7) choose Restart each page. 

To use the same footnote index multiple times referencing through Cross-reference 

should be used to avoid creating multiple footnotes with the same content.  

3.3 Adding figures and applying style formatting  

Adding figures and captions correctly into text document is not easy. Therefore, thesis 

template provides a style Figure to simplify the process. This style adds a frame to a 

figure, and ensures proper spacing around it (Figure 8).  

The following describes how to properly use the style Figure to add and format figures 

in thesis. 

  

Figure 7. Footnote settings. 

 

Figure 8. Taltech logo.  
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The line preceding to a figure must be ended with pressing the Enter key.  

1. Figure should be inserted on this new line by choosing Insert, Picture. 

2. Before applying style Figure to inserted figure, make sure that the layout of the figure 

is In Line with Text. For the latter activate the figure and open Layout Options from 

the button next to the figure as shown on Figure 9, or use the command Picture Tools, 

Format, Wrap Text, and choose In Line with Text. 

3. If the layout is In Line with Text, apply the style Figure. This forces the figure to be 

centred horizontally with proper space around it. 

4. Making sure the figure is still active (if not, select it again) a caption is added by 

choosing References, Insert Caption (Figure 10), where a caption „Figure” is shown, 

followed by a space and a number added automatically.  

NB! Do not enter any caption title to this field!  

5. After pressing OK, the beginning of figure caption is placed under the figure. Add a 

dot and a space after the figure number, and type the caption title. The template 

ensures that the caption can occupy the whole width of the page. Proper formatting is 

ensured by style Caption. If your caption is longer than one line, apply style 

Caption_multiline to caption text, or choose align Justify (Figure 2). 

 

Figure 9. Setting figure layout options before applying the style Figure. 

 

Figure 10. Adding caption to figure. 
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The figure is placed into Frame together with its caption and anchored to the nearest text 

paragraph. NB! To display the anchor, toggle the Show/Hide  option in the menu and 

activate the frame (not the figure itself) in which the figure is.  

Anchor can be relocated to another text paragraph, i.e., if text is pushed onto next page 

the figure will follow it in case it is anchored to the paragraph. If a figure is placed outside 

the margins, check the anchor and relocate the figure upwards or to the following page.  

If a figure is a group of illustrations, the style Figure cannot be applied and an approach 

described in Appendix 9 must be used. 

3.4 Bulleted lists and numbered lists 

The style for the bulleted list is List Bullet, which provides a single-level bulleting, for 

example: 

▪ One 

▪ Two 

▪ Three 

To end bulleted list, press the Enter key twice. This forces the word processor to end the 

list although the style will remain to be List Bullet. Re-apply style Body Text to the 

paragraph following the bulleted list.  

Creating and ending numbered lists is alike. The style in the template is List Number.  A 

problem may occur when a new numbered list is created with the same style as the 

numbering is continued from the previous list, for instance:  

 

Figure 11. Figure 8 formatted with the style Figure, and a frame surrounding the figure-caption pair. 



27 

6. This list is continued from a previous list presented on page 25. To restart numbering 

from 1, open a context menu with right click and choose Restart at 1:  

For multi-levelled lists use the Multilevel List option from the menu toolbar and define 

appropriate rules. 

3.5 Using tables in MS Word 

Tables are a convenient way to organize information and its layout. Tables can contain 

text, numbers and graphics. Tables can also be used to design page layout, for example 

as has been done with the title page of this document and thesis template. 

3.5.1 Creating and altering tables 

To insert a table into document, place a cursor on the line where you want the table to be 

placed and choose the Insert tab Table – a dropdown menu is opened with additional 

options (Figure 12 a). 

The first option to add table is to select the required amount of boxes in the window with 

a mouse, and a table is immediately inserted. 

The second option is to click on Insert Table which calls an options window (Figure 12 b) 

where the Number of Columns and Number of Rows can be specified together with 

column width. The default is Auto, which means the table takes up space from left to right 

page border.  

 

Figure 12. Options to create tables: (a) table creation settings, (b) table settings.  

 

Figure 13. Drawing a table with the Draw Table option. 
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With the Draw Table option one can draw a table using an on-screen pen. This option is 

helpful in sketching layout design. Table drawing starts with setting the outer borders by 

drawing a rectangle followed by slicing it into cells (Figure 13). 

After a table has been created and the cursor is in table Table Tools tab is displayed with 

two subtabs Design, and Layout (Figure 14). 

The Design tab (Figure 14) has the following setting groups: Table Style Options, Table 

Styles, Draw Borders. Enabling the Header Row option under Table Style Options sets 

MS Word to duplicate table header automatically in case the table spans across 

multiple pages.  

The Layout tab (Figure 15) contains the option groups Row & Columns, Merge, Cell Size, 

Alignment, and Data. 

After creating a table using one of the alternatives described above, it is ready to be filled 

with data. The cursor needs to be placed into the cell where data will be inserted. The data 

can be either text, numbers, lists, or graphics.  

To move between the cells, use either the Tab-key or arrow keys on the keyboard. 

Pressing the Tab-key in the last cell of the table automatically adds a new row at the end 

of the table.   

Pressing the Enter-key inside a cell creates a new line inside a cell (the height of the cell 

will increase) and paragraph spacing is applied. It is not recommended to use this option 

inside table cells.  

If the text does not fit into the cell it will be automatically transferred to the next line 

within the cell. To break the text in a particular point, add a line break with the key 

 

Figure 14. Table tools and the options of the Design tab. 

 

Figure 15. Table Tools and the options of the Layout tab. 
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combination Shift+Enter. For formatting table layout, the options on the Table Tools 

toolbar under Table Properties can be used (Figure 16). 

NB! Table border lines are not always used and shown (e.g., the table of List of 

abbreviations and terms). Table gridlines can be displayed by activating View Gridlines 

from Table Tools, Layout under the Table group.  

3.5.2 Aligning decimal numbers in table cell 

Numbers should always be aligned by decimal place and not in any other way (align left, 

right, etc.). To align numbers by their decimal place in table column: 

1. Display the ruler from View, Ruler and click the top left corner until the Decimal 

Tab icon appears. 

2. Activate the column containing decimal numbers and click an appropriate place on 

the ruler to place the decimal placeholder (Figure 17). 

 
 

Figure 16. Options for formatting table, table row, column or cell. 

 

Figure 17. Aligning decimal numbers in table cell. 
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3.6 Adding captions to figures and tables  

There are two options to add a caption: use the command Insert, Reference, Caption, or 

right-click on figure and from the context menu choose Caption. Captions that are added 

using the command Caption are automatically numbered and controlled by MS Word. 

After the command Caption a dialogue window is opened where the options for caption 

can be set, or a new label created by pressing the New Label button.  

NB! The title of the caption is not entered here in this window – it is typed in after the 

caption label has been placed to a figure or table. 

MS Word will automatically update the numbers and their sequential order when adding 

a new caption into document. If any of the captions is removed, an update is needed – for 

this the whole document needs to be selected (Select all or Ctrl+A), right click on selected 

text and choose Update Field from the menu, or alternatively press F9. All captions are 

formatted using the style Caption. For captions that are longer than one line the style 

Caption_multiline or align Justify is applied in addition. 

3.7 Using cross-references 

Frequently there is a necessity to refer to a figure, table, section, footnote or any other 

part of a document that has a certain style applied to it. For text that is not defined by 

style, a bookmark can be set (Insert, Bookmark). Cross-references have a particular 

structure as shown on Figure 18.  

1. To place a cross-reference at cursor, choose References, Cross-reference or 

Insert, Cross-reference. 

2. The Cross-reference dialogue window will open. 

3. After the selection of Reference type (e.g., Table) a list of all titles connected to 

particular reference type in the document is displayed. Mark the Insert as Hyperlink 

to allow the cross-reference to act as a link inside the document. 

4. From the Insert reference to list choose the appropriate option of presentation 

(e.g., Only Label and Number). 

5. Press Insert. A field with cross-reference is added. 
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Figure 18. Structure of cross-references.  

To update a cross-reference, choose the cross-reference field, perform a right-click on 

it and choose Update Field. 

3.8 Creating and updating table of contents, lists of figures and tables  

To generate a list of figures or tables activate the line No table of figures entries found 

under the heading “List of figures” / “List of tables” in the template, perform right-click 

and choose Update field. The field No table of figures entries found is replaced with a list 

of figures / tables found in the document, based on their captions. This procedure 

presumes that figures and tables are formatted as described in this document. 

To update Table of contents, act alike – activate the list of contents, perform right-click 

and choose Update field. 

To create Table of contents, List of figures, or List of tables use the command References, 

Table of Contents or Insert Table of Figures. The latter is necessary if you choose not to 

use the provided template. 

3.9 Creating a numbered list of references  

In case the number of references is small, the list of references can be added manually as 

a numbered list (or alternatively using a table layout). The style for numbered list of 

references is List_bibliogr.  

The formatting using this style is shown after the heading “References” following this 

paragraph. In thesis the heading References is always a level 1 heading without a number 

(style Heading_unnumber).  

Text added by author  

(in bold) 

see Table 1, page 6 

Alternating fields added with  

Insert, Cross-reference 
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To use items from the reference list in your main text, cross-references can be used 

(References, Cross-reference or Insert, Cross-reference). The type of the reference is 

Numbered Item and the selection for the Insert reference to option is Paragraph number 

(no context). As a result, the cross-reference is added into text as [1] . Ctrl+Left-click will 

take to the list of references to a referred source record. 

NB! If the number of references is larger, you should opt for the MS Word built-in 

Citations & Bibliography option available under References (see Appendix 8).  

3.10 Saving thesis as a PDF-document  

It is advisable to save prepared and finished thesis in Portable Document Format (PDF). 

This will ensure the thesis is readable cross-platform and the layout is fixed. To save the 

document in PDF: 

1. Choose File, Export, Create PDF/XPS Document, 

2. Press the PDF/XPS button.  

3. From the Publish as PDF… window set the Options (Figure 19) for the PDF-file to 

be created.  

 
 

Figure 19. File, Export Create PDF Document options. 
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4 Using LibreOffice Writer for preparing thesis  

This section addresses issues common for word processing with LibreOffice Writer 

(version 5, in further noted also as LO), in particular composing text, inserting tables, 

figures, adding captions to the latter, managing list of references and so forth.   

In parallel to installable software there also exists a portable version of LibreOffice that 

can be downloaded from http://www.libreoffice.org/download/portable-versions/ and run 

from computer or external media (e.g., USB stick) without a need to install.  

The LibreOffice Writer template in the author’s toolkit is established to help authors in 

preparing their thesis. Proper use of the template ensures correct formatting of thesis and 

the author can focus on content only. 

Opening the template, you will see pre-defined document parts with constant text and 

changeable parts shown in square brackets – these should be changed according to thesis 

contents by clicking on the text and inserting new content – the template will take care of 

proper formatting. 

The numbered headings in thesis are formatted using predefined styles Heading 1, 

Heading 2, Heading 3. After you have typed the heading, applied proper style and pressed 

the Enter key at the end of the heading line, the next line will be formatted for content 

text input automatically having its style set to Body Text. This style ensures proper 

formatting of paragraphs and their spacing. 

4.1 Text entering and layout  

The rules to follow while entering text are presented in Section 2.10 of this document. 

Text formatting should be done using styles available in the provided template. All styles 

available in the template are listed in Table 1. 

This section covers also necessary additional procedures for setting up LibreOffice Writer 

to start preparing thesis. 
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Formatting of single words or phrases – bold, italic, etc. – is done using the options on 

the toolbar (Figure 20). 

In addition to paragraph styles, LO uses page, list, and frame styles. The Styles and 

Formatting panel opens in LO (version 6 and later) in the right column of the work 

window as shown on Figure 21. 

 

 

The set of styles that are displayed on the Styles and Formatting panel can be set from 

the last row at the end of the panel, e.g., Custom Styles, Applied Styles, All Styles. 

To apply a style to text, place cursor in the text and double-click on the style name (e.g., 

Heading 1). Styles can be applied through the panel (Figure 21) or using the toolbar 

button (Figure 20).  To view or modify style settings, right-click on style name on the 

panel and choose Modify. For example, the Text Flow property of style Heading 1 allows 

to specify that all first level headings start with a new page (Figure 22).  

After applying heading style to section title and pressing the Enter key, a new line is 

created with the style Body Text, which is the proper style for all paragraph text content 

in thesis. 

From the Organizer tab (Figure 22) it is possible to set the style that follows the current 

style; e.g., in case of Heading 1 the selection is Body Text. 

 

Figure 20. Toolbar with style options and settings for text properties. 

Figure 21. The Styles and Formatting panel. 
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4.2 Bulleted lists and numbered lists 

The style for the bulleted list is List Bullet, which provides a single-level bulleting, for 

example: 

▪ One 

▪ Two 

▪ Three 

To end bulleted list, press the Enter key twice. This forces the word processor to end 

the list although the style will remain to be List Bullet. Re-apply style Body Text to the 

paragraph following the bulleted list.  

Creating and ending numbered lists is alike. The style in the template is List Number.  A 

problem may occur when a new numbered list is created with the same style as the 

numbering is continued from the previous list. To restart numbering place cursor at the 

end of the first numbered line, open a context menu with right-click and choose Restart 

Numbering . 

 

 
 

Figure 22. Style properties window. 
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4.3 Footnotes 

Footnotes are added at the bottom of the page, just above the bottom margin. Numbering 

of footnotes is restarted on each page. The proper style for footnotes is Footnote. Before 

adding a footnote, it is necessary to set its style. As this cannot be bound to defined styles 

in LO, it has to be done by the author manually by choosing Tools, Endnotes/Footnotes 

and setting the numbering style (Figure 23).  

To add a footnote, place a cursor in the text at the place where you want your footnote 

reference to appear and choose Insert, Footnote. After confirming it with OK, a 

placeholder is created at the bottom of the page. Type your footnote text and apply style 

Footnote. The footnote is above the margin and is separated from the text with a short 

line.  

4.4 Adding formulas 

LibreOffice uses a program called Math to add equations. To use Math choose Insert, 

Object, Formula. For more information please refer to LO Help. The inserted equation is 

placed into a Frame that has a style Formula.  

4.5 Inserting program code 

In order to list program code in your thesis according to the requirements (Section 2.8.3) 

do the following: 

1. Type/Copy program source code so that the first line starts at the left margin of the 

page.  

 

Figure 23. Footnote settings. 
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2. Select program code and apply style Program_code. 

3. In order to be able to add caption to program code it is necessary to select the code 

and add a frame to it (Insert, Frame), and then apply frame style Program, which 

places source code in a page-wide frame. 

4. Activate (Select) the frame and add caption using the command Insert, Caption. 

5. Apply style Caption_multiline as necessary (captions longer than one line only). 

6. To locate program code horizontally to the centre of page, select the code and use the 

Increase Indent option on the toolbar. 

The screenshot from LO text document on Figure 24 shows an example program code 

formatting.  

4.6 Adding figures and their captions 

To insert figures into thesis in LO use the command Insert, Image. Then add a caption 

using the command Insert, Caption. In the Insert Caption window (Figure 25) add the 

caption title text (field Caption on top of the window) and set necessary options – the 

final result is shown immediately on the Preview field.  

From the Options (Figure 25) Caption order is set – in thesis the proper order is label 

Figure, followed by a space and figure number. There is a dot and space at the end of the 

figure number before caption text. Captions are formatted using style Caption or 

Caption_multiline; these styles place the figure in a page-wide frame. If a figure is 

narrow, e.g., the example shown on Figure 26, then figure caption obtains the maximum 

width of the figure. To change this (as necessary by the requirements presented in this 

 

Figure 24. An example program code and its correct formatting as a screenshot from LibreOffice Writer. 
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document) apply frame style Figure to the frame. In LO the frame around the figure is 

always shown on screen but never printed out.  

 

4.7 Working with tables 

Tables are a convenient way to organize information and its layout. Tables can contain 

text, numbers, lists and graphics. Tables can also be used to design page layout, for 

example as has been done with the title page of this document and thesis template. 

To add a new table place cursor on new line and use the command Table, Insert Table or 

insert table button on the toolbar (Figure 27). The button More options under the Insert 

Table button allows setting of different options, including repeating heading rows on new 

pages (Figure 28).   

 

Figure 25. Insert Caption window in LibreOffice Writer. 

 

Figure 26. Example: adding figure in LibreOffice Writer. 
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After inserting a table, use the style Table_head to format table header row and style 

Table_text to format table content rows.  

If a cursor is placed into table, then a table toolbar is displayed at the bottom of the 

LibreOffice window (Figure 29), providing tools to alter table options, add and remove 

rows/columns, align table data, or add table caption.  

4.7.1 Adding table caption 

Table captions are inserted using the toolbar command button or menu command Insert, 

Caption. The process is alike to adding captions to figures (Section 4.6), where in the 

Insert Caption dialogue window selection of settings has to be made (Figure 30). The title 

of table caption is inserted into the field Caption.  

NB! Table captions are always placed above the table – select Position: Above (Figure 

30). 

 

Figure 27. Toolbar to add tables. Insert Table button is the last in the row. 

 

Figure 28. Setting repeating headings for table and adjusting table borders. 

 

Figure 29. Table toolbar. The last button enables to add table caption. 
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After the caption has been placed above the table apply style Caption or 

Caption_multiline (only for captions longer than one line).  

4.7.2 Aligning decimal numbers in table cell 

Numbers should always be aligned by decimal place in tables. To align numbers by 

decimal place, display the ruler (View, Ruler), and click on the top left corner until the 

Decimal Tab icon appears . Then select the column containing decimal numbers and 

click an appropriate place on the ruler to place the decimal placeholder (Figure 31).  

 

Figure 30. Settings in the Insert caption window for table captions. 

 

Figure 31. Aligning decimal numbers in table cell. 



41 

4.7.3 Centring a table 

To centre a table horizontally use the Table toolbar Table Properties button  or the 

command Table, Table Properties and in the Table Format window mark Center as 

shown on Figure 32. The Table Format window also allows to set free space above and 

below the table. 

4.8 Using cross-references 

Frequently there is a necessity to refer to a figure, table, section, footnote or any other 

part of a document that has a certain style applied to it. For text that is not defined by a 

style, a bookmark can be set (Insert, Bookmark). Cross-references have a particular 

structure as shown on Figure 18.  

1. To place a cross-reference at cursor choose Insert, Cross-reference. 

2. The Fields window will open with options shown on Figure 33. 

3. From the Type list select the type of cross-reference you want to add. For example, if 

you chose Table all titles for tables in the document are displayed in the Selection 

field. Choose the appropriate title there.  

4. From the Insert reference to list choose the appropriate option of presentation 

(e.g., Category and Number).  

5. Press Insert. A field with cross-reference is added at the current place of cursor.  

 

Figure 32. Setting table alignment to the centre of page. 
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If you click on the cross-reference, the document location that is referenced to, is shown.  

4.9 Creating numbered list of references 

In case the number of references is small, the list of references can be added manually as 

a numbered list (or alternatively using a table layout). The style for numbered list of 

references is List_bibliogr. The formatting using this style is shown after the heading 

“References” following this paragraph. In thesis the heading References is always a first 

level heading without a number (style Heading_unnumber).  

References 

[1]  S. Froning, “Low energy communities with district heating and cooling”, Dublin: PLEA, 

2008.  

[2]  Hovedrapport, “Udvikling og Demonstration af Lavenergifjernvarme til 

Lavenergibyggeri”, (in Danish), 2009.  

 

Figure 33. Adding cross-reference in LO. The options window. 
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To use items from the reference list in main text, cross-references can be used (Insert, 

Cross-reference). The type of the reference is Numbered Paragraphs and the selection 

for the Insert reference to option is Number (Figure 34). As a result, the cross-reference 

is added into text as for example: [1]  

If cursor is placed on the reference in square brackets, the item referenced is shown 

(Figure 35). Double-click will take to references list. 

 

 

Figure 34. Adding a cross-reference to a bibliography reference. 

 

Figure 35. Cross-reference to a bibliography reference. 
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4.10 Saving thesis as a PDF-document  

It is advisable to save prepared and finished thesis in Portable Document Format (PDF). 

This will ensure the thesis is readable cross-platform and the layout is fixed.  

To save the document in PDF: 

1. Choose File, Export as PDF…  

2. In the PDF Options window set the options (Figure 36) and click Export.  

 

 

 

 

Figure 36. PDF Options window in LO for creating PDF documents. 
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Appendix 1 – Example of the non-exclusive licence for 

reproduction and publication of a graduation thesis 
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Appendix 2 – Title page layout 

The layout of the title page here is displayed with table gridlines to highlight the structure. 

The rows below supervisor data can be used to add secondary supervisor, consultants etc. 

as necessary. 
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Appendix 3 – Example of Author’s declaration of originality  
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Appendix 4 – Example of the Abstract page 
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Appendix 5 – Example of the List of figures 
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Appendix 6 – Example of the List of tables 

 

 

 



51 

Appendix 7 – Example of the List of abbreviations and terms  

The table below is shown with gridlines (these are not printed) to illustrate table structure. 
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Appendix 8 – Managing bibliography references with Word  

It is possible to use MS Word’s built-in feature of bibliography references. The 

functionality is available from the References menu. In Appendix 8 the style used to 

exemplify the process is IEEE 2006. Using this style, the references are inserted in square 

brackets, e.g., [1]. 

Details of a new bibliography record are entered using the command Manage sources, 

and selecting New. The source type can be book, article, journal, etc. (Figure 8-1). After 

selecting source type, the details of the used source are entered (Figure 8-2).  

By adding all used sources in this way into your thesis document, the outcome is a 

references source list with a Master List saved in the computer. This Master list will 

contain all sources that have been entered using MS Word. A list called Current List 

contains all bibliography references used in current document. Both of these lists are 

presented in the Source Manager window available through References, Manage Sources 

(Figure 8-3). 

 

Figure 8-1. Adding reference details through Source Manager. Selection of source types. 

 

Figure 8-2. Inserting reference details. 
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To cite a book, article or any other source in the text use References, Insert Citation and 

choose the source record (Figure 8-4). 

A reference as a number in square brackets is inserted. The Edit Citation option 

(Figure 8-5 a) allows to modify the reference, e.g., add a page number (Figure 8-5 b). 

  

Figure 8-3. Using Source Manager. 

 
 

Figure 8-4. Selecting source to add as a reference in text. 

 

Figure 8-5. Adding a source reference: (a) reference in the text, (b) changing reference details. 
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To generate the list of bibliography used in the document, use the References, 

Bibliography command (Figure 8-6). Choose the appropriate style or use 

Insert Bibliography at the bottom of the dialogue box. 

As a result, a list of references is generated and inserted into document (as shown below):  

References 
 

[1]  L. S. Sterling, The Art of Agent-Oriented Modeling, London: The MIT Press, 2009.  

 

…or as Building Block seen on Figure 8-7. 

NB! In case the choice Insert Bibliography is used to add a list of references, the list is 

inserted as a table and the author needs to add a first level heading References for the list 

if it is not yet added into the document. 

 

 

Figure 8-6. Generating the list of references. 

 

Figure 8-7. List of references added to document.  
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Appendix 9 – Adding and formatting figures with Word  

Inserting figures into document is done using the Insert, Picture command. Clicking on 

the inserted figure activates (selects) it and text wrapping options are shown next to the 

figure (Figure 9-1). 

Figure formatting 

1. Select figure 

2. From the top menu select Picture Tools, Format  

3. Select Wrap Text and option Top and Bottom, this ensures there is no text on the left 

or right side of the figure 

4. To centre the figure, choose Format, Position, More Layout Options and set figure 

alignment (Figure 9-2). 

 

5. To ensure there is enough space below the figure choose from the Text Wrapping tab 

option Distance from text and set its Bottom value to 1 cm (Figure 9-3). 

Figure 9-1. Text wrapping options. Presently Top and Bottom option is selected. 

Joonis 8-2. Pildi horisontaalse paigutuse seadistused. Figure 9-2. Horizontal layout options. 
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6. From Format, Position, More Layout Options tab Position set the options shown on 

Figure 9-4 and verify that the figure is anchored to the paragraph it belongs to.  

 

NB! The figure formatted as above is anchored to the nearest text paragraph, which can 

be verified when the Show/Hide option of invisible symbols is activated; the anchor is 

displayed as . It is possible to lock the anchor, which means it cannot be moved to 

another text paragraph. 

The menu Picture Tool, Format also provides other options for figure formatting, such 

as brightness correction, contrast, and also compression under command Compress 

Pictures, which is useful to apply after cropping or to reduce file size (Figure 9-5). For 

printing the document resolution should be enough.  

 

Figure 9-3. Setting the distance between text and figure. 

Figure 9-4. Anchoring figure to a text paragraph. 

Figure 9-5. Figure compression options. 


